
•• Using the on-line help ••

The help module consists of two lists.  The list on the left, contains the topics.  User
can select a topic by scrolling up or down and clicking in the desired subject.  The 
list on the right would display the help text associated with the list item selected.  
The help window can be dragged around by click-dragging in the title bar.  User 
can quit the help module by clicking the go-away box on the top left corner of the 
help window.

•• About DictationMachine ••

From  the  Author  of  MicroRecorder™,  AudioClock™,   MicroRecorder  Pro™
VoiceCalendar™,   and  Focus  TeleContact™,  Focus  DictationMachine™  is
functionally equivalent to a transcribing device.  It allows continuous background
recording and playback of sound from hard disk.  This would allow you to work with
other programs while the sound is being recorded or played in the background.
Among the key features of the DictationMachine are:

*- Full asynchronous Record and playback of sound. 
*- 100 percent user configurable voice activated recording (VOX). 
*- Supports Apple Events.
*- Supports AppleTalk and connection to remote sites.
*- Online/off-line help module.
*- Full system 7 balloon help support.
*- Drag and drop capability.
*- Support for 3:1 and 6:1 compression of the recorded sound.
*- Fast forwarding and rewinding of sound being played.
*- Volume adjustment.
*- Pitch adjustment.
*- Threshold adjustment.
*- Delay adjustment.
*- Elapsed and remaining time display in hundredth of second accuracy.
*- Bar indicator for the portion of sound played.
*- Quick Skip feature allowing to instantly to jump to any section of tape.
*- Pausing and stopping capabilities.
*- Audio Selection and selection display.
*- Repeated play.
*- Insert and remove any portion of tape with a click of mouse.
*- Miniaturizing windows for saving desktop space.
*- Excellent 3D graphical interface and animation!
*- Full utilization of the notification manager.



*- Real-time sound display for record and playback states!!

•• System Requirements ••

    •  Hardware:  68020,  68030,  or  68040  or  Power  PC  Macintosh.  (Any  LC,
Powerbook, Quadra, Centris, Performa, families of Macintosh computers.)

    • Color or gray scale monitor (256 colors or 16 level gray scale recommended).

    • System 7 and higher.

    • Sound manager 3.0 for best results.

    • 350 K of free memory.

    • Apple built in or third party microphone for  recording sound.

•• Quick jump feature

when the mouse cursor is move on top of the progress bar (located directly below
the real-time digital display),  the cursor changes to a marker (from its original
arrow shape) indicating it  is ready to select a location.  If  the mouse button is
clicked anywhere in the progress bar when the marker is presented, any action
(play, fast forward, and rewinding) is stopped and playback is initiated from that
point  in  tape.   However,  if  the  user  is  recording,  this  marker  would  not  be
presented.  Therefore, when recording, user must first stop the tape before the
marker is available for use.

•• Adding in a sound segment

It is often needed to edit in a segment of recorded sound into an already recorded
tape.  This tape addition capability allows the user to simply modify the tape rather
than recording the entire content all over again to include the changes needed.
For example, if the recorded sound is "One...Two...Three...Four", user can modify it
to "One... Two... Hello... Three... Four".  If the "Add" option is not selected, the tape
would be overwritten 



and it would be something like "One... Two... Hello... Four" which would overwrite
the word "Three". 

To add in (edit in) a new segment into an already recorded tape , the following two
steps must be taken:

    1) Rewind fast forward, or play to the location and then mark where on the tape
the  new portion  should  be  inserted  by  either  clicking  on  the  "Add"  button  or
selecting the "Add" option in the "Edit" menu.  The add button would begin flashing
indicating that tape addition has been initiated and recording begins.

    2) After the new portion has been recorded, user can stop addition by either
clicking on the "Add" button or  selecting the "Add"  option in  the "Edit"  menu.
Recording stops and the "Add"  button would  stop flashing indicating that  tape
addition has stopped.

•• Removing a sound segment

It  is  often  needed  to  remove  a  segment  of  recorded  sound  from  an  already
recorded tape.  This tape removal capability allows the user to simply modify the
tape rather than recording the entire content all over again to include the changes
needed.  For example, if the recorded sound is "One...Two...Three...Four", user can
modify it to "One...Two...Four" erasing the word "Three".  

To remove (erase) a segment from an already recorded tape , the following two
steps must be taken:

    1) Mark the beginning of the portion to be erased.  This is done by simply
rewind, fast forward, or play to the point of desire and clicking the erase button or
selecting "Erase" item in the "Edit" menu.  The erase button would begin flashing
indicating that tape eraser has been initiated.

    2) Rewind, fast forward, or play to another point in tape and mark the end of
erase selection by either clicking the erase button or selecting the "Erase" from the
"Edit" menu.

The start point and end point for erase could be any where on the tape.  Start point
does not have to be smaller that the end point.  For example, the start of erase
could be marked at 12.29 seconds elapsed and the end 



point  could  be  marked  at  3.09  seconds  elapsed.   The  erase  process  will
automatically take care of the ends of the range and that portion of the tape is
removed from the tape.

•• Compression Levels ••

Dictation Machine allows the user to select a to select the desired compression 
level at the time a tape is created.  Compressing and decompressing of the tape is 
done transparently and once the desired level is selected, user never has to do 
anything and everything is done automatically thereafter.  Compressing the 
recorded sound would help to save disk space.  At 22 KHz sampling rate, with no 
compression each second of recorded sound will take approximately 22k of disk 
space.  With 3 to 1 compression one second of sound will take 7.6k of space and at
6 to 1 compression only requires 3.8k of disk space.  The disk space used to store a
tape is greatly reduced through compression, however the compression process 
will somewhat reduce the fidelity of sound recorded.  The 3 to 1 compression offers
a compromise between disk space and quality of sound.

•• Drag and drop feature ••

The Focus DictationMachine fully supports the drag and drop feature of system 7.  
This would allow the user to simply drag a tape on to the application for 
processing.  Since only one tape can be open at any time, dropping more than one 
tape would result in the first tape in the group to be opened only.

•• Balloon help ••

The Focus DictationMachine fully supports the balloon help feature of system 7.  To
activate the balloon help, either select "Show Balloons" from the finder's help 
menu or select "Balloon Help" from DictationMachine's "Display" menu.



•• Menus:

This section contains the descriptions for the following menus:
    - Apple Menu
    - File Menu
    - Edit Menu
    - Sound Menu
    - Tape Menu
    - Display Menu

•• Apple Menu ••

Use  this  menu  to  access  Apple  menu  items  or  obtain  information  about  the
DictationMachine.   The on-line help module can also be accessed through this
menu.

• About • 
This menu item to learn more about the DictationMachine Application.

• Help •
Use this menu item to activate the on-line help module.  This module has extensive
help  text  describing various  features  of  the  DictationMachine and how to  fully
utilize them.

•• File Menu ••

Use this menu to perform operations related to disk, file, printer, windows, or to
quit the application.

• New... •
To create  a  new blank tape,  simply  choose this  menu item and select  various
options such as sampling rate, compression ratio and whether or not you wish the
tape to be standalone.

• Open... •
This menu item allows the user to open a previously recorded tape for playback or
modification.  User may also simply drag the tape onto the DictationMachine to
open it for use.

• Save As... •



Use this menu item to save a backup of the current tape under a different name or
location.  This feature makes it easy to have several versions of the tape.  That
way after  making certain modifications,  user  can simply step back to an older
version if they are not happy with the changes.

• Close •
Use this menu item to unload or close the currently loaded tape.  After closing the
currently open tape, user can then open another tape or create a new tape to work
with.

• Quit •
This menu item can be used to quit DictationMachine application and return to the
Finder.

•• Edit Menu ••

Items in this menu can be used to modify or manipulate the recorded sound.  

The  Undo,  Cut,  Copy,  Paste,  and  Clear  item  are  not  currently  used  by
DictationMachine  and  are  provided  for  use  with  Apple  Menu  Items  (Desk
Accessories) only.

• Add •
Use this menu item to edit in (add) a sound portion any length in to a pre-recorded
tape.  When this item is selected, it would be marked to indicate that the tape
addition has been initiated.  User can also select the "Add" button from the main
window to achieve the same effect.  See the topic "Adding in a sound segment" for
more details.

• Erase •
User can use this menu item to delete (erase) a sound portion of any length from a
pre-recorded tape.  When this item is selected, it would be marked to indicate that
the tape eraser has been initiated.  See the topic "Removing a sound segment" for
more details.

• Make Standalone •
This menu item allows users to create a standalone tape which can be played by it
self and would not require the DictationMachine to play on other computers.  When
sending another person a tape that you created, this feature allows them to have
access to all playback features of the 



program  without  the  requirement  of  having  their  own  copy  of  the
DictationMachine.  The tape however, can only be played back and could not be
edited  by  the  recipient  of  the  tape  unless  they  have  the  full  version  of  the
DictationMachine available.

• Capture Settings •
Use this menu item to adjust preferences for playback and recording features of
the current tape.  Once this menu item is selected, every time "Reset" button is
pressed, the setting would return to these settings.  The setting that are recorded
for future use are the delay, volume, threshold, and sensitivity values.

• Capture Defaults •
Use this menu item to adjust preferences for playback and recording features of
DictationMachine.  Once this menu item is selected, all proceeding tapes created
would use the settings at the time of selection.  The setting that are recorded for
future tapes are the delay, volume, threshold, and sensitivity values.

•• Sound Menu ••

Use the items in this menu to adjust various characteristics of the sound recording
and  playback.   The  following  describes  various  user  adjustable  parameters
allowing the users to customize the DictationMachine to their individual needs.

• Master Volume •
Use this menu item to adjust the computer's main output volume.  This option
modifies  the  settings  used  by  all  applications  currently  running  (including
DictationMachine).  This overall control can be used to reduce the system beep
sound or  sounds  being  created by  any other  program employing  audio  output
feature.  Additionally, the application allows the user to alter the settings used by
DictationMachine only which is described in the next section.

• Volume •
Use this menu item to adjust the DictationMachine's output volume.  The changes
made  through  this  menu  item  effect  only  the  audio  output  behavior  of  the
DictationMachine.  This parameter can also be adjusted to the desired value using
the volume up and down keys in the main display.  



To learn how to change the master volume see the previous section.  

• Sensitivity •
Use this menu item to adjust the DictationMachine's sensitivity level (threshold) for
voice activated recording.  The sensitivity parameter determines the loudness level
which would trigger the DictationMachine's recording feature once in record mode.
The advantage of this feature is the ability to avoid pauses and silence between
spoken words which take unnecessary extra disk space.  The values are from 0 to
100.  The zero value would cause any sound that is detected to be recorded.  The
100 value  would  cause the  recording to  be  activated on  extremely  loud noise
which meet or exceed the maximum possible.  An intermediate value, for example
40,  would  cause all  sound with  loudness below 40 percent  of  maximum to  be
ignored.  This threshold feature allows the users to customize the DictationMachine
to  the  environment  in  with  it  is  being  operated.   The  background  noise  (i.e.
computer's  fan, office equipment,  personal stereo,  keyboard clicks etc.)  can be
eliminated by adjusting the threshold.  The sensitivity level controls the recording
behavior  in  recording  mode  only.    If  the  user  is  playing,  stopping,  pausing,
rewinding or fast forwarding, this parameter would have no effect.  The pop-up
menu allows quick setting from 0 to 100 in steps of ten.  The sensitivity  up and
down buttons in the main window allow fine tuning in steps of one percent.

• Delay •
Use this menu item to adjust the DictationMachine's delay time for voice activated
(VOX) recording.  The delay parameter describes the time that DictationMachine
waits before recording is stopped after the loudness has fallen below threshold.  To
illustrate the need for this feature let us look at a word such as "Stop" where the
"ST" have more emphasis than the "OP" portion.  When the word "stop" is used in
normal conversation, the "op" portion is slightly pronounced at a lower level than
the "ST".  If the delay is set at a relatively low value and threshold is set above the
level at which "op" is spoken, it would be cut off.  For example a sentence such as
"....Please stop at..." could be recorded as "...please sto at...".  By having control of
the delay  and sensitivity  parameters,  users  can customize  DictationMachine to
their way of speaking.  The pop-up menu allows adjustment of the delay value
from 0 to 1 second in steps of 0.10 second (100 milliseconds).  The delay value can
also be adjusted using the delay up and down buttons in the main window.  The
delay up and down buttons in the main window allow fine tuning in steps of 0.01
second (10 milliseconds).



• Playback Rate •
Use  this  menu  item to  adjust  the  DictationMachine's  playback  rate  (pitch)  for
playback.   If the spoken words were to quick or too fast for user's typing speed,
the pitch of the sound could be lowered to a desirable value.  Alternatively, if the
speed of the spoken word were too slow, speed of playback could be increased to
save typing time.  The pop-up menu provides adjustment of the rate from 50 to
175 percent (in steps of 25 percent) of the speed at which the sound was recorded.
Additionally,  the  playback  rate  could  be  adjusted  using  the  rate  up  and  down
buttons in the main window in steps of one percent.

• Button Clicks •
The  clicks  are  provided  for  user  feedback.   Use  "Button  Clicks"  menu item to
able/disable the click sound associated with clicking buttons and controls.  When
the DictationMachine is  controlled  from inside  another  application,  these clicks
would provide the user with an audio feedback which would indicate the course of
action requested has been taken.  However, during business meetings or a quite
work environment, it may be desirable to mute these clicks.  Once the clicking
sound is disabled, it would remain disabled until the application has restarted or
the menu item is selected again.

•• Tape Menu ••

Use this menu to control the DictationMachine or obtain information about the tape
currently loaded.  The following describes various controls allowing the users to
alter the DictationMachine's playback and record behavior.

• Tape Info •
Use this menu item to obtain information about the currently loaded tape.  Upon
selection,  the  characteristics  such as  tape's  name,  sampling rate,  compression
ratio, sampling resolution, standalone status, total size in bytes and total record
time in seconds are displayed.

• Repeat •
Use this menu item to start playback of the sound after it has reached the end
(auto replay).



• Reset •
Use this menu item to reset all applicable parameters to their default values.  To
set the default values  to be used in conjunction with this menu item, see the
description for "Capture Settings" and "Capture Preferences" items descriptions in
the Edit menu.

• Record •
Use this menu item to start voice activated recording.  If prior to selecting this
menu item the DictationMachine was in  playback,  rewinding or  fast  forwarding
mode, it would stop the tape, reset the related parameters and begin the recording
process.

• Play •
Use this menu item to start playback from disk.  If prior to selecting this menu item
the DictationMachine was in recording, rewinding or fast forwarding mode, it would
stop the tape, reset the related parameters and begin the playback process.

• Fast Forward •
Use this menu item to fast forward the tape.  If prior to selecting this menu item
the DictationMachine was in recording, rewinding or playing mode, it would stop
the tape, reset the parameters and begin the fast forwarding process.

• Rewind •
Use this menu item to rewind the tape.  If prior to selecting this menu item the
DictationMachine was in recording, fast forwarding or playing mode, it would stop
the tape, reset the parameters and begin the rewinding process.

• Stop •
Use this menu item to stop recording, playback, rewinding, or fast forwarding.

• Pause •
Use this menu item to pause recording or playback of the tape.

• Skip To Start •
Use this menu item to quickly move to the beginning of the tape.  Once selected,
any playback, recording, fast forwarding or rewinding would be stopped and the
tape would return to the beginning.

• Skip To Start •



Use this menu item to quickly move to the end of the tape.  Once selected, any
playback, recording, fast forwarding or rewinding would be stopped and the tape
would return to the end.

•• Display Menu ••

Use this menu to control the characteristics of the DictationMachine for display
related settings.

• Playback Display •
Use this menu item to activate/deactivate real time playback display.  When in
playback mode, the digital display portion of the main window displays the actual
sound being played in real time.  By selecting or deselecting this item user can
optionally turn on or off this display.  If the tape was recorded with compression
however, this item is disabled.  Due to overwhelming amount of CPU time required
for  real-time  decompression  and  display  to  occur  concurrently,  the  display  of
compressed sound in  real  time is  not  supported.   Supporting such feature will
greatly effect overall  performance of the computer,  resulting in  a general  slow
down of other programs running.

• Record Display •
Use this menu item to activate/deactivate real time record display.  When in record
mode, the digital display portion of the main window displays the actual loudness
and selected threshold for the sound being recorded in real time.  By selecting or
deselecting this item user can optionally turn on or off this display.

• Level Indicator •
Use this menu item to activate/deactivate the record level indicator.  In the record
mode, the record level is indicated in the main screen in form of a bar.  This option
is selected at start up (default) and can be turn on/off by the user thereafter using
this menu item.

• Menu Bar Notifications •
Use  this  menu  item  to  activate/deactivate  notification  in  the  menu  bar.   The
current state of the DictationMachine is displayed by a flashing icon over the apple
icon (top left corner of screen) when this option is selected.  This option is selected
at start up (default) and can be controlled by the user thereafter using this menu
item.



• Shrink •
Use this menu item to iconize the main window to preserve desktop space and
reveal windows of other applications running.

• Expand •
Use this menu item to increase the DictationMachine's main window size to reveal
all controls and displays.

• Balloon Help •
DictationMachine fully supports the system 7 balloon help feature.  Use this menu
item to activate/deactivate the balloon help.   Once this  option is  selected,  the
balloon help is activated for DictationMachine and any other application running.
Users can also activate the balloon help by selecting "Show Balloons" option in the
help menu of the system 7 from the finder.

• Keyboard Controls •
Use this menu item to view the keyboard controls which allow you to control the
DictationMachine from inside other applications.  Upon selection, user is presented
with  a  dialog  which  would  displays  and  animate  the  method  for  use  of  the
keyboard  control  feature.   The  keyboard  controls  allow the  user  to  stop,  play,
record, fast forward, and rewind the tape from inside any application. This feature
take  away  the  cumbersome  task  of  switching  application  just  to  control  the
DictationMachine's actions.  Additionally, since the keyboard control is done in a
unique way internally, there is no need for a startup (extension or INIT) program
which may cause conflict with system programs.

• Brightness •
This submenu allows the user to adjust the brightness of the display elements in
the main window.  Depending on depth of color or shades of gray available on the
computer that the DictationMachine is running on,  the readability of  the digital
displays can be increased by adjusting the brightness.  The default value for the
brightness is 1.  If the DictationMachine is running on a black and white display,
the default values are setup automatically to white.  

•• Windows ••
This  section  describes  various  windows of  the DictationMachine.   The windows
described in this section are:



     - Miniature Window 
     - Help Window 
     - Main Window 

•• Miniature Window ••

From the main window, user can activate this window which allows the user to 
save precious desktop space.  Furthermore, since other application can be used 
concurrently with DictationMachine, miniaturizing the main window would give 
other application more processing time.  User can return to the main window by 
pressing the expand button.  User can drag the miniature window around the 
desktop by clicking-dragging anywhere in the window except the expand button.

•• Help Window ••

This window contains all the on-line help text available for the application.  The 
window is a standard Macintosh application window with two sections.  First section
is the topics and the second is the text associated with the topic.  User can 
activate the on-line help module by selecting the "Help" menu item from the apple 
menu.  See the "How to use the on-line help" section on more details on the usage.

•• Main Window ••

The  following  describes  all  of  the  elements  in  the  main  window  of  the
DictationMachine.

• Close Box •
By clicking in this box which is located in top left corner of the main window, you
can close the currently loaded tape.

• Title window •
The name of the tape currently loaded is displayed in the top right corner of the
main window.  If no tape is loaded, it would indicate that user must either create
anew tape or open a tape previously created.

• Drag Region •
Using this region with series of horizontal lines, user can drag the window 



around the desktop to reveal underlying windows of other applications.

• Shrink/Expand •
Using this box located on the top right corner of the main window to shrink the
main window to make more desktop space visible and reveal windows of other
applications..

• Volume •
Current volume level selected for the playback of sound is displayed in the digital
display portion.  The volume setting (range of values are 0 to 100 percent) can be
adjusted by the up (+) and down (-) buttons below the volume display.

• Sensitivity •
Current  sensitivity  level  selected for the recording of  sound is  displayed in the
digital  display  portion.   The  sensitivity  setting  (range  of  values  are  0  to  100
percent) can be adjusted by the up (+) and down (-) buttons below the sensitivity
display.

• Rate •
Current rate (pitch) value selected for the playback of sound is displayed in the
digital display portion.  The rate setting (range of values are 0 to 400 percent) can
be adjusted by the up (+) and down (-) buttons below the rate display.

• Delay •
Current Delay selected for stop of the recording of sound is displayed in the digital
display portion.  The delay setting (range of values are 0 to 1 second) can be
adjusted by the up (+) and down (-) buttons below the delay display.

• Remaining •
In the record mode this portion displays the amount of time available for recording
(based on hard disk space).  In playback mode it indicates remaining portion of the
recorded sound.

• Elapsed •
This  display  shows the  current  time elapsed when in  playback  mode,  and  the
recorded time in the record mode.

• Rewind •
This control  button can be used to rewind the tape to a desired position while
hearing an audio feedback which can aid in the selection process.



• Play •
Initiate playback using this control button.

• Fast Forward •
This control button can be used to advance the tape to a desired position while
hearing an audio feedback which can aid in the selection process.

• Record •
Use this control button to initiate recording to tape.

• Pause •
Use this control button to either pause recording or playback.

• Stop •
Use this control button to either stop recording or playback.

• Level Indicator •
This bar is the record level indicator.  The values below threshold are in red and the
above threshold values are in blue (in gray scale light and dark gray respectively).

• Sound Display •
When recording this portion displays the current record level and threshold.  In
playback mode, this portion displays the actual sound being played in real-time.

• Progress Display •
This  portion  displays  the completed versus  remaining time of  either  recording,
playback, or tape editing in progress.  You can also use this portion to quickly jump
to any point in the tape by simply clicking in it.  See the "Quick jump feature" for
more details.

• Erase •
Use this  button to select and erase a portion of  the recorded sound.  See the
"Removing a sound segment" section for more details.

• Add •
Use this button to add a sound in to an already recorded sound.  See the "Adding in
a sound segment" section for more details.

• Help •



This  button  would  activate  the  on-line  help  module  which  has  more  detailed
descriptions of the various features of the DictationMachine than offered with the
balloon help windows.

• Skip To Start (left) •
Use this button to make a quick skip to the beginning of the tape.

• Skip To End (right) •
Use this control button to make a quick skip to the end of the tape.

• Open •
Select this button to be presented with a dialog which allows you to select a tape
to open for playback and recording.

• New •
Using this button you can create a new blank tape for recording.

• Reset •
Click  this  button  to  return  volume,  rate,  sensitivity,  and  delay  to  the  values
selected in the preferences settings.  See the description for the "Reset" item in
the "Tape" menu for more details.

• Repeat •
Selecting this button would cause the playback to start again from the beginning of
the tape once it reaches the end (auto replay).

•• Warranty/Liability ••

This software is released on an "AS IS" basis. The author provides no warranty of 
any sort. The user of this software assumes complete responsibility for any direct 
or indirect damages due to use or misuse of this software.  This program including 
but not limited to the code is copyrighted by Focus Softworks and Afshin Latifi and 
is NOT public domain (strictly enforced).  It may not be disassembled, reverse 
engineered, redistributed, copied or modified.

•• How to reach the author ••

Please E-Mailed questions, comments, bug reports to:



America Online :Latifi
Internet : latifi@aol.com

or by Mail to the address displayed in the introductory screen.

•• Commercial and Shareware Distribution ••

This or any of other works of this author shall not be distributed without prior 
written consent of the author (strictly enforced).  Requests for distribution can be 
submitted to the address displayed in the introductory window.  Only signed official
request would be considered.

•• Other Focus Softworks products ••

The following are the list of products at the time of release of this version of Focus 
DictationMachine™:

• MicroRecorder™- 
- Is a sound player which allows background sound playback on any 

Macintosh with color capability in AIFF format.  It features unlimited record and 
play back time, repeated playback, on-line help, volume adjustment, and audio 
selection.  The audio selection allows the user to play back a portion or the entire 
sound.  This program has three dimensional controls, animation, and digital display
featuring playback time, audio selection, volume level.

• MicroRecorder Pro™- 
- Based on the popular MicroRecorder, the pro version has the same features 

with the addition of pitch control, REAL TIME! display of the sound, Stereo 
capability, and left/right channel control.  Furthermore, MicroRecorder Pro supports 
AIFF, system 7 sound file, and PC/Windows wave format.  The support for 
PC/Windows format allows the user to import their favorite sound from the other 
platform.

• AudioClock™- 
- Is a digital Alarm Clock.  It is a Clock for people who appreciate 



efficiency.  It allows the user to enter daily messages by specifying the time, 
occasion, recording the voice message and save with clicks of mouse all without 
typing a word!.  User can also preview the messages using their mouse.

• VoiceCalendar™- 
- Is a digital calendar.  First of its kind, it is a calendar for people who hate to 

type! or people who appreciate efficiency.  It allows the user to enter daily 
messages by specifying the date, time, occasion, recording the voice message and
save with clicks of mouse all without typing a word!.  User can also view the entire 
month, select any date and play back any messages using their mouse.

Look for these on America Online, your favorite bulletin boards and the Internet.  

For latest version information or questions see "How to reach the Author" section.

AudioClock, MicroRecorder, MicroRecorder Pro, VoiceCalendar, and 
DictationMachine are trademarks of Focus Softworks.
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